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Užívateľská pracovná plocha, práca so súborom a zošitom. 

 

 

 
  

 

Princípy pre prácu s menu v programe MS Excel sú podobné ako v programe MS Word. Máme tu pás 

kariet, kontextové menu (vyvolané cez pravé tlačidlo myši), panely nástrojov a nová položka podokno 

úloh. Príkazy v menu, za ktorými sú bodky vyvolávajú dialógové okno, príkazy so šípkou vyvolá 

podmenu a ostatné sú priamo vykonateľné. 

Pracovná plocha je delená na bunky. Aktívna bunka je práve zvýraznená bunka a s touto bunkou je 

možné vykonávať bežné operácie, ako vkladanie textu, vzorcov, formátovanie a iné... Na pohyb po 

bunkách je možné využiť šípky na klávesnici, alebo sa jednoducho kurzorom myši nastavíme nad 

bunku a označíme ju. Existujú klávesové skratky, ktoré nám urýchlia pohyb po pracovnom zošite: 

 

Ctrl + SHIFT + →  označí celý riadok od aktuálnej bunky vpravo 

Ctrl + SHIFT + ← označí celý riadok od aktuálnej bunky vľavo 

Ctrl + SHIFT +  označí celý stĺpec od aktuálnej bunky dole 

Ctrl + SHIFT +  označí celý stĺpec od aktuálnej bunky hore 

Home presun na prvú bunku aktuálneho riadka 

Ctrl+Home presun na bunku A1 

Ctrl+End presun na pravý dolný roh tabuľky 

Pg Dn posun o stránku dole 

Pg Up posun o stránku hore 

Ctrl+Pg Dn posun o hárok vpravo   

Ctrl + Pg Up posun o hárok vľavo 

Pole názvov – adresa aktuálnej 

bunky 

Jednotlivé hárky – Hárok1, Hárok2, 

Hárok3 

Bunka – je označená adresou 

napr. L8 

Stavový 

riadok 

Vzorcový panel 

Pás kariet Domov, Vložiť, ... Pomocník 
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Vysvetlivky k typu kurzorom 

 

 

Vkladanie jednoduchého vzorca a funkcie 

Činnosť Vysvetlenie 

Vkladanie jednoduchého vzorca 

 
Jednoduchý vzorček vložíme: 

1. Kliknutím do bunky, kde chceme 

výsledok 

2. Každý vzorček musí začínať znakom 

rovná sa (=) 

3. Po stlačení znaku rovná sa (=) na 

klávesnici klikneme na bunku, ktorú 

chceme zahrnúť do výpočtu (zamodrí sa) 

4. Na klávesnici stlačíme vhodný 

matematický operátor 

+ (sčítanie) 

– (odčítanie) 

* (násobenie) 

/ (delenie) 

5. Na klávesnici klikneme na bunku, ktorú 

chceme zahrnúť do výpočtu (zazelení sa) 

6. Potvrdíme klávesou ENTER alebo  

7. Výsledok je na svete ☺ 

Vkladanie jednoduchej funkcie 
 

Jednoduchú funkciu vložíme: 

Typ kurzora Činnosť 

 

Označenie bunky alebo oblasti buniek (ťahaním 

a držaním ľavého tlačidla myšky) 

 

Premiestnenie obsahu bunky ťahaním a 

držaním ľavého tlačidla myšky. 

Ak je pri tom zatlačená klávesa CTRL tak 

kopírovanie obsahu bunky 

 

Kopírovanie obsahu (hodnoty, vzorca) bunky do 

susedných buniek ťahaním a podržaním ľavého 

tlačidla myšky  (vodorovne alebo zvislo) 

      

Zmena šírky stĺpca/výšky riadka 
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1. Kliknutím do bunky, kde chceme 

výsledok 

2. Kliknutím na šípočku vpravo v karte 

Domov od  (Automatický súčet) 

vyberieme vhodnú funkciu 

a. Súčet (SUM) 

b. Priemer (AVERAGE) 

c. Počet (COUNT) 

d. Maximum (MAX) 

e. Minimum (MIN) 

3. Ťahaním myši pri stlačenom ľavom 

tlačidle zvolíme oblasť, ktorú Excel 

zahrnie do „výpočtu” 

4. Potvrdíme klávesou ENTER alebo  

5. Výsledok je na svete ☺ 

Formátovanie buniek 

Činnosť Vysvetlenie 

Zmena čísla na menu (Sk, Euro) Kliknutím na konkrétnu bunku s číslom a potom 

na  

Zmena meny (napr. na EURO) Pravým tlačidlom zvoliť Formátovať bunky a tam 

Účtovnícke. V pravej časti zvolíme počet 

desatinných miest a symbol meny (kliknutím na 

šípočku navolíme symbol €) 

 

 
Zrušenie meny Zrušenie meny rovnakým postupom ako pri 

Zmena meny. Pravým tlačidlom Formátovať 

bunky zvolíme Všeobecné (príp. kliknutím na  

Číslo, ak chceme zaokruhliť na presný počet 

číslic) 

Zaokrúhlenie hodnoty (pridať/odobrať 

desatinné miesta) 
Kliknutím na konkrétnu bunku a potom na  

ak chceme pridať desatinné miesto (čiže 

upresniť číslo) alebo na ikonku  ak chceme 
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odobrať desatinné číslo (čiže znepresniť číslo). 

Na dané ikonky môžeme klikať viackrát, kým 

nedosiahneme potrebný výsledok. 

 

Kopírovanie a premiestňovanie buniek 

Činnosť Vysvetlenie 

Kopírovanie obsahu buniek  1. Označíme oblasť buniek, ktoré chceme kopírovať 

2. Použijeme klávesovú skratku CTRL + C (klávesu CTRL 

držíme ako dlho chceme, klávesu C stlačíme raz). Okolo 

danej oblasti „bliká” prerušovaná obvodová čiara 

3. Kliknene na bunku, kde chceme vložiť skopírované bunky 

4. Použijeme klávesovú skratku CTRL + V (klávesu CTRL 

držíme ako dlho chceme, klávesu V stlačíme raz) 

5. A je to! ☺ Ak sa nepodarilo, postup musíme zopakovať 

(všímajte si, či „bliká” prerušovaná obvodová čiara okolo 

kopírovaných buniek) 

Pozn.: Týmto spôsobom sa dá skopírovať obsah buniek do 

Microsoft Word (alebo iného programu) 

Premiestnenie obsahu buniek Rovnako ako pri kopírovaní, namiesto CTRL + C použijeme CTRL 

+ X 

 

 

Pridanie/odstránenie stĺpca/riadka 

Činnosť Vysvetlenie 

Nový stĺpec Klikneme do akéjkoľvek bunky v stĺpci pri 

ktorom chcem vložiť nový stĺpec. Pravým 

tlačidlom zvolíme Vložiť ... -> Celý stĺpec. Nový 

stĺpec sa vloží naľavo od aktuálneho stĺpca 

(aktuálny stĺpec sa posunie doprava) 

Nový riadok Klikneme do akéjkoľvek bunky v stĺpci pri 

ktorom chcem vložiť nový riadok. Pravým 

tlačidlom zvolíme Vložiť ... -> Celý riadok. Nový 

riadok sa vloží nad aktuálny riadok (aktuálny 

riadok sa posunie smerom dolu) 

Odstrániť stĺpec Klikneme do akéjkoľvek 

bunky v stĺpci, ktorý chceme 

odstrániť.  Pravým tlačidlom 

zvolíme Odstrániť ... -> Celý 

stĺpec.  Pozor: Týmto 

spôsobom odstránime celý 

stĺpec v Microsoft  Exceli.  Ak to nechceme 

dosiahnuť zvolíme možnosť Posunúť bunky 
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doľava (predtým však 

vyznačíme oblasť buniek, 

ktoré chcem odstrániť). 

Odstrániť riadok Rovnako ako pri odstraňovaní stĺpca, namiesto 

Celý stĺpec zvolíme Celý riadok 

 

Vloženie, odstránenie a premenovanie hárka 

Činnosť Vysvetlenie 

Ukážka hárkov 

  
 

Vloženie hárka Pravým tlačidlom nad 

akýmkoľvek hárkom 

zvolíme možnosť Vložiť 

a potom OK. 

Premenovanie hárka Pravým tlačidlom nad akýmkoľvek hárkom 

zvolíme možnosť Premenovať 

Odstránenie hárka Pravým tlačidlom nad akýmkoľvek hárkom 

zvolíme možnosť Odstrániť 

Kopírovanie / premiestnenie hárka Pravým tlačidlom nad konkrétnym hárkom 

zvolíme možnosť Premiestniť alebo kopírovať... 

 
 

Absolútny odkaz (fixácia bunky) 

 

Činnosť Vysvetlenie 

Na čo je dobrý absolútny odkaz (fixácia bunky)?  Absolútny odkaz vo vzorci, napríklad $A$1, vždy 

odkazuje na bunku na určitom mieste. Ak sa 

zmení pozícia bunky obsahujúcej vzorec, 

absolútny odkaz zostane rovnaký. V prípade 

skopírovania alebo vyplnenia vzorca do 

viacerých riadkov alebo stĺpcov sa absolútny 
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odkaz neupraví. Výhoda: nemusíme danú bunku 

kopírovať do riadkov, kde sa s ňou pracuje pri 

„výpočte” 

Ako na to? Pri 

vkladaní 

vzorca 

konkrétnu bunku zafixujeme použitím klávesy 

F4 

 

Zoradenie údajov 

Činnosť Vysvetlenie 

Zoradenie údajov vzostupne/zostupne Údaje v Microsoft Excel zoradíme 

cez Zoradiť a filtrovať v karte 

Domov vzostupne (od A po Z) cez   

ikony  alebo zostupne (od Z 

po A) . Prv než zoradíme, klikneme do 

stĺpca, podľa ktorého budeme zoraďovať (napr. 

ak máme tabuľku zamestnancov s menom a 

priezviskom a chceme zoraďovať podľa 

priezviska, klikneme kdekoľvek do bunky v stĺpci 

priezvisko) 

 

Automatický filter 

Činnosť Vysvetlenie 

Filtrovanie údajov pomocou Automatického 

filtra 

V prípade práce s veľkým množstvom údajov, 

Microsoft Excel ponúka možnosť triedenia 

údajov pomocou automatického filtra. Na 

základe automatického filtra si vyberieme iba tie 

údaje, ktoré sú pre nás v danú chvíľu potrebné 

(napr. pri tabuľke zamestnancov nás zaujíma, že 

kto pochádza z Banskej Bystrice 

Ako na to? V karte Domov zvolíme Zoradiť a 

filtrovať a v ňom Filter. Tým istým 

spôsobom Filter vypneme. Pri 

aktivovaní automatického filtra 

sa nad každým stĺpcom zobrazí 

šípka. Po kliknutí na šípku sa 

rozbalí menu s údajmi. Kliknutím 

na daný údaj potvrdíme 

kritérium filtrovania (podľa 
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obrázka kliknutím na Západná zobrazí všetkych 

zákazníkov z tejto oblasti) 
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Tvorba grafu 

Činnosť Vysvetlenie 

Čo je graf Graf vytvárame pre lepšiu čitateľnosť údajov v tabuľke, pričom sa riadime 

heslom „Lepšie raz vidieť ako tisíc krát počuť”. Pomocou grafu môžeme 

robiť rýchle porovnania, napr. pri grafe počtu vyrobených výrobkov za 

určité obdobie porovnáme počet výrobkov za jednotlivé obdobia (viď 

obrázok nižšie). Každý graf, okrem prezentovaných údajov, by mal min. 

pozostávať z názvu, popisu osi X, osi Y a legendy.  

 

 
Zdroj: http://static.chandoo.org/img/2010/introduction-to-excel-

sparklines.png  

Ako vytvoriť graf - 

postup 

1. Klikneme kdekoľvek do oblasti buniek (údajov), ktoré chceme 

zobraziť v grafe 

2. Klikneme na ikonu v páse kariet zvolíme Vložiť  a zvolíme 

konkrétny graf (Stĺpcový, Čiarový, ..) 

Počet vyrobených výrobkov za obdobie 2003 až 2005

0
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http://static.chandoo.org/img/2010/introduction-to-excel-sparklines.png
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3. Tvorba grafu tvoria štyri základné piliere 

1)  Výber typu grafu (stĺpcový, pruhový, čiarový, 

koláčový, atď.) a ich podtypy. Nie všetky typy grafov sa 

hodia pre všetky typy údajov.  

2) Pri grafe sa zobrazia nové pásy kariet a to Návrh, 

Rozloženie a Formát.  

 

Navrh v ňom môžeme nastaviť napr. typ grafu, rozloženie grafu, oblasť 

údajov (v prípade ak chceme zobraziť iba časť údajov v grafe). Nesúvislá 

oblasť sa označuje klávesou CTRL. 

 

Rozloženie – zadávame názov grafu, os X a os Y ale nastavujeme napr. 

umiestnenie/zobrazenie legendy, os X a Y, mriežky, menovky, atď. 

 

Formát – Celkový vzhľad grafu, dá sa aj v karte Domov ako pri formátovaní 

textu 

 

Vo verzii Microsoft Excel 2013 a vyš je manipulácia s grafom jednoduchšia: 

 
Premiestnenie grafu Výsledný graf môžeme premiestniť kliknutím do bieleho miesta v grafe a 

ťahaním do strán pri stlačení ľavého tlačidla myši. 
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Zväčšenie / 

zmenšenie grafu 

Zväčšiť alebo zmenšiť graf môžeme kliknutím v 

rohovom mieste grafu pri zobrazení dvojšípky (šipky od 

seba) 

Dodatočná zmena v 

grafe 

Klinutím na graf v menu aktivujeme pásy kariet Návrh, Rozloženie a 

Formát, viď časť Ako vytvoriť graf – postup vyššie 

Formátovanie grafu Formátovaním grafu (na danú oblasť 2x ľavým tlačidlom, príp. pravym 

tlačidlom a zvoliť Formátovať ...)sa dá zmeniť farba, veľkosť zobrazovanej 

oblasti, názvu, legendy, atď.  

Zmazanie grafu Kliknutím na graf a potom klávesa DELETE 

 

Tlač, ukážka pred tlačou a nastavenie strany 

Činnosť Vysvetlenie 

Aktivácia ukážky pred tlačou Pred samotnou tlačou si môžeme pozrieť 

ukážku pred tlačou kliknutím na tlačidlo , 

teda to, čo naozaj po tlači uvidime. Z ukážky 

pred tlačou odchádzame kliknutím na tlačidlo 

Zavrieť. 

Pozn: Po zavretí Ukážky pred tlačou sa v  celej 

tabuľke zobrazia prerušované zvislé a 

vodorovné čiary, ktoré vyjadrujú hranice tlače 

(napr. formátu A4) 

Tlač Tlać aktivujeme kliknutím na tlačidlo  príp. v 

menu Súbor -> Tlačiť..., kde môžeme zadať 

konkrétny počet strán, kópií, atď. 

Nastavenie strany Pri tlači väčších tabuliek je vhodné zmeniť 

orientáciu stránky na šírku (naležato), prípadne 

okraje. Nastavenie strany nájdeme v páse kariet 

Rozloženie strany -> Nastavenie strany ... 

 

Údaje v MS Excel a ich rozdelenie 

Karta Home > skupina Number (Karta Domov > skupina Číslo) 

Pravé tlačidlo myši > Format Cells... (Formátovať Bunky ...) 

 

Údaje do bunky v Microsoft Excel vpíšeme podobne ako pri Microsoft Word. V prostredí Microsoft 

často pracujeme so zaokrúhlenými číslami, menou (napr. €), percentami, zlomkami a podobne. Túto 

zmenu dokáže Excel urobiť za nás, preto nie je potrebné do bunky nič dopisovať. Hovoríme o tzv. 

formátovaní buniek. Formátovanie buniek nám ponúka karta Home (Domov) v skupine Number 

(Číslo), príp. pravým tlačidlom do bunky a výberom možnosti Format Cells (Formátovať Bunky). 
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Máme na výber nasledovné formátovania 

 

 
 

Ukážka: 

Číslo 

bez 

formátu 

Aplikované 

formátovanie čísel 

Typ 

formátovania 

(EN) 

Typ 

formátovania 

(SK) 

1 1 General Všeobecné 

2 2,00 Number Číslo 

-3 -3,00 € Currency Mena 

-4 -                              4,00 €  Accounting Účtovnícke 

5 05.01.1900 Short Date Krátky dátum 

6 piatok, 6. január 1900 Long Date Dlhý dátum 

7 0:00:00 Time Čas 

8 800,00% Percentage Percento 

0,9  8/9 Franction Zlomok 

10 1,00E+01 Scientific Vedecké 

11 11 Text Text 

97411 974 11 Special Špeciálne 

13 13,00 kg Custom Vlastné 

Poznámka:   
Rozdiel medzi Accounting (Účtovnícke) a Currency (Mena) je v 

odsadení hodnoty a záporného znamienka. Taktiež záporné 

čísla v prípade potreby pre Currency môžeme označiť červenou 

farbou. 
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V prípade Special (Špeciálne) máme k dispozícii prednastavené 

formáty čísel napr. pre PSČ alebo tel. číslo 

    

V prípade Custom (Vlastné) musíme definovať masku formátu, 

napr. 0,00 " kg" nám zabezpečí zobrazenie jednotiek kg 

zaokrúhlených na dve desatinné miesta 

    
Ak chceme vrátiť bunku späť do stavu bez použitia 

formátovania, zvolíme General (Všeobecné) 
 

Formátovanie údajov 

Karta Home (Domov) 

 

Pod formátovaním údajov si predstavíme zmenu vzhľadu obsahu buniek a to napr. ich veľkosti, farby, 

použitia orámovania, zarovnanie, ale aj formátovanie čísel v bunke (viď kapitolu Údaje v MS Excel a 

ich rozdelenie). 

 

Zmena vzhľadu obsahu buniek 

Funkcionalita známa z prostredia Microsoft Word. Môžeme zmeniť typ písma, veľkosť písma, rez 

písma (tučne, kurzíva a podčiarknuté), orámovanie, farbu bunky (farba výplne) a farbu písma. 

Na to využijeme skupinu Font (Písmo) na karte Home (Domov). 

 

  
 

Pomôcť nám môže aj minitoolbar, ktorý aktivujeme pravým tlačidlom kliknutím do bunky s obsahom. 

Minitoolbar obsahuje najpoužívanejšie tlačidlá na formátovanie buniek. 

 

 
 

Viac možností nám ponúka pravé tlačidlo myši, ktoré aktivujeme nad bunkou a vyberieme Format 

Cells ... (Formátovať bunky ...) 
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Okno Format Cells – karta Number (Okno formátovať bunky – 

karta Číslo) 

V okne Format Cells... (Formátovať bunky...) nájdeme niekoľko kariet. 

Prvá z nich je Number (Číslo), ktorým meníme formát čísel (viac v kapitole 

Údaje v MS Excel a ich rozdelenie) 

 

 

Okno Format Cells – karta Alignment (Okno Formátovať bunky – karta Zarovnanie) 

Druhá karta v poradí je Alignment (Zarovnanie). V nej nájdeme možnosti ohľadom zarovnania 

buniek. Tie sú delené do skupín: 

 

 
 

Text alignment (Zarovnanie textu) – horizontálne (Horizontal) alebo vertikálne (Vertical) zarovnanie.  

 

Text control (Nastavenie textu) obsahuje: 

Zalamovanie textu (Wrap text)  
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Prispôsobiť bunke (Shrink to fit)  

Zlúčenie buniek (Merge cells)  

 

 

Right-to-left (Sprava doľava) – orientácia textu sprava doľava v prípade špeciálnych jazykov ako je 

arabčina. 

 

Orientation (Orientácia) – znázorňuje uhol naklonenia textu. 

 

Poznámka: Alignment (Zarovnanie) nájdeme v karte Home (Domov) a to v skupine Alignment 

(Zarovnanie).  

 

 
 

Okno Format Cells – karta Font (Okno Formátovať bunky – karta Písmo) 

Štandardná ponuka formátovania buniek, tak ako poznáme v Microsoft Word. 

 

 
 

Okno Format Cells – karta Border (Okno Formátovať bunky – karta Orámovanie) 

Orámovanie buniek. Naľavo vyberáme štýl čiary (Style), farbu (Color). Napravo máme ukážku 

orámovanej bunky, ktorú klikaním vyplníme (príp. aplikovaním prednastavených orámovaní v Presets 

= Preddefinované). 
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Okno Format Cells – karta Fill (Okno Formátovať bunky – karta Výplň) 

Výplň bunky farbou (pozadie bunky).  

 
 

Okno Format Cells – karta Protection (Okno Formátovať bunky – karta Ochrana) 

V Microsoft Excel je možné zakázať jednotlivé bunky pred prepisovaním (Locked = Zamknúť bunky), 

dokonca je možné zakázať zobrazenie vzorca (Hidden = Skryť vzorce). Aktivácia týchto funkcií je až po 

zamknutí hárka (karta Review > Protect Sheet = Revízia > Zabezpečiť hárok) 
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Formátovanie tabuľky 

Karta Home > Format as Table (Karta Domov > Formátovať ako tabuľku) 

 

Tabuľku môžeme sformátovať veľmi rýchlym spôsobom a to použitím tlačidla Format as Table 

(Formátovať ako tabuľku) v karte Home (Domov). Predtým označíme celú tabuľku alebo stačí 

označiť jednu bunku v nej. 

 

 
 

Po kliknutí na naformátovanú tabuľku máme k dispozícii kartu Design (Návrh). 

 

 

Vkladanie hlavičky a päty. Číslovanie strán 

File > Print > Page Setup (Súbor > Tlačiť > Nastavenie strany) 

Prejde do súboru, zvolíme Tlačiť a Nastavenie strany. 
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V okne Nastavenie strany zvolíme Vlastná hlavička alebo päta. Podľa potreby zvolíme 

Vlastná hlavička... alebo Vlastná päta... 

 

 
 

Máme na výber do ktorej časti dokumentu vložíme text alebo jeden zo „systémových“ 

príkazov. Tie sa delia nasledovne: 

 

 - Formátovať text. Naformátuje text podľa potreby 

 - Vložiť číslo strany. Vloží číslo strany do aktuálne pozície kurzora. 

 - Vložiť počet strán. Vloží celkový počet strán konkrétneho hárka 

 - Vložiť dátum. Vloží aktuálny dátum 

 - Vložiť čas. Vloží aktuálny čas 
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 - Vložiť cestu k súboru.  Vloží aktuálnu cestu (umiestnenie) k otvorenému súboru 

- Vložiť názov k súboru. Vloží aktuálny názov otvoreného súboru 

- Vložiť názov hárka. Vloží aktuálny názov aktuálne otvoreného hárka 

 - Vložiť obrázok. Vloží obrázok, ktorý je potrebné vyhľadať na PC. 

 - Formátovať obrázok. Aktívne v prípade, ak je vložený obrázok. Dovoľuje formátovať –

(zmeniť veľkosť, orientáciu alebo orezenie)obrázok podľa potreby. 

 

 
 

Ukotvenie priečok 

Zobraziť > Ukotviť priečky > Ukotviť priečky (View > Freeze Panes > Freeze Panes) 

Použijeme v prípade, že chceme pri prezeraní údajov ponechať (ukotviť) prvý riadok (obyčajne 

hlavička tabuľky) alebo prvý stĺpec.  

 
 

Tlač nadpisov 

Page Layout > Print Titles (Rozloženie strany > Tlačiť názvy) 
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Funkcionalita užitočná pri tlači nadpisov (napr. hlavičky tabuľky) na každej strane. Je potrebné označiť 

práve ten riadok, ktorý sa bude opakovať. 

 

Prispôsobenie veľkosti 

Page Layout > Scale to Fit (Rozloženie strany > Prispôsobenie veľkosti) 

View > Page Break Preview (Zobraziť > Ukážka zlomov strán) 

Pri tlači niekedy zbytočne tlačíme strany s jedným stĺpcom alebo pár riadkami. Excel dokáže 

automaticky prispôsobiť veľkosť šírky, resp. výšky strany pomocou Rozloženie strany, kde nájdeme 

skupinu Prispôsobenie veľkosti. Zmeniť môžeme napr. Mierka. Podobné možnosti nájdeme aj pri 

Súbor > Tlačiť.  

Ďalšia možnosť je upraviť zlomy strán (Zobraziť > Ukážka zlomov strán). Excel nám prepne vzhľad do 

režime, kde „hýbeme” modrými čiarami. Prerušovaná čiara práve zobrazuje koniec strany. 

 

Funkcia ROUND 

Karta Formulas -> Math & Trig (Vzorce > Matematické & Trigonomické) alebo kliknutím na tlačidlo 

fx -> Math & Trig -> ROUND (fx > Matematické & Trigonomické > ROUND) 

 

Popis 

Funkcia ROUND zaokrúhli číslo na zadaný počet číslic. 

 

Syntax 

ROUND(číslo, počet_číslic)Syntax funkcie ROUND obsahuje nasledovné argumenty (argument: 

hodnota poskytujúca informácie pre akciu, udalosť, metódu, vlastnosť, funkciu alebo procedúru.): 

 

Číslo - povinný argument. Číslo, ktoré sa má zaokrúhliť. 



Mgr. Ján Žitniak | www.ITeducation.sk | +421 903 790 704 | info@iteducation.sk 

22 

 

Počet_číslic - povinný argument. Počet číslic, na ktorý chcete zaokrúhliť argument číslo. 

 

Ukážka 

Ak napríklad bunka A1 obsahuje číslo 23,7825 a chcete túto hodnotu zaokrúhliť na dve desatinné 

miesta, môžete použiť nasledujúci vzorec: 

=ROUND(A1; 2) 

 

Výsledkom funkcie je hodnota 23,78. 

Funkcia IF 

Karta Formulas -> Logical (Vzorce > Logické) alebo kliknutím na tlačidlo fx -> Logické -> IF 

Použitie v prípade ak potrebujeme v bunke rozhodnúť podľa kritéria. Napr. chceme určiť, či 

konkrétna prevádzka splnila normu alebo nie podľa počtu vyrobených kusov.  

Cieľ: Chceme vypísať, či prevádzka splnila 

normu alebo nesplnila. Kritérium splnenia 

normy je 100 a viac vyrobených kusov. 

Postup: Klikneme do bunky, kde chceme získať 

rozhodnutie. Vložíme funkciu IF, ktorá od nás 

očakáva tri argumenty (Logical_test, 

Value_if_true, Value_if_false pričom prvý iba 

Logical_test je povinný), ktoré vyplníme podľa 

obrázka vpravo.  

Do časti Logical_test klikneme do bunky, ktorú 

hodnotíme, čiže v našom prípade je to bunka 

s počtom vyrobených kusov.  

Ďalej zadáme znamienko väčšie (> zadáme cez pravý ALT + .) a rovná sa (=). Následne dopíšeme číslo 

100. 

V argumente Value_if_true zadáme odpoveď (textová, číselná alebo vo forme vzorca), ktorá sa 

zobrazí v prípade ak podmienka je splnená (v našom prípade text: Splnená). V políčku Value_if_false  

zadáme odpoveď ak podmienka nie je splnená (v našom prípade text: Nesplnená). 

Funkcia SUBTOTAL 

Karta Formulas > Math & Trig Formulas (Vzorce > Matematické & Trigonomické) alebo kliknutím na 

tlačidlo fx > Math & Trig > SUBTOTAL 

 

Popis 

Funkcia SUBTOTAL sa používa na výpočet medzisúčtov vo filtri alebo databáze. Pod medzisúčtom 

myslíme nielen sčítanie, ale aj priemer, počet, maximum, minimum, viac v tabuľke číslo_funkcie 

nižšie. V prípade filtra nemôžeme použiť bežnú funkciu ako je SUM, AVERAGE, COUNT, MAX, MIN 

a podobne, pretože tie do výpočtu zahrňuje aj „zakryté“ hodnoty. 

 

Syntax 

= SUBTOTAL(číslo_funkcie,odk1,[odk2],...]) 
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číslo_funkcie – vyjadruje funkciu, ktorá pri výpočte zahŕňa alebo ignoruje skryté hodnoty. 

 

Číslo funkcie  

(zahrňuje aj skryté hodnoty) 

Číslo funkcie  

(ignoruje aj skryté hodnoty) 

Funkcia 

1 101 AVERAGE 

2 102 COUNT 

3 103 COUNTA 

4 104 MAX 

5 105 MIN 

6 106 PRODUCT 

7 107 STDEV 

8 108 STDEVP 

9 109 SUM 

10 110 VAR 

11 111 VARP 

 

odk1, odk2 – oblasť buniek filtra alebo databázy nad ktorými sa aplikuje medzisúčet. Ekvivalent 

prostredníctvom formulára: 

 

 

Konverzia vzorcov na hodnoty 

Karta Home -> Paste/Paste Special... (Domov > Prilepiť/Prilepiť špeciálne) 

 

Vzorce v tabuľke môžeme previesť na hodnoty (potom v danej bunke už nebudeme vidieť vzorec). 

Postup je nasledovný: 

Označenú tabuľku skopírujeme a vložíme špeciálne (Karta Home -> Paste (Domov > Prilepiť)) 
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Zobrazenie toku údajov v hárku 

Karta Formulas -> Trace Precedens (Vzorce > Predchodcovia) 

Karta Formulas -> Trace Dependents (Vzorce > Následníci) 

Karta Formulas -> Remove Arrows (Odstrániť šípky) 

 

Vo vzorci potrebujeme odsledovať, ktoré bunky vzorec „využíva” alebo naopak, kde sa ďalej 

vypočítaný výsledok používa. Na to použíjeme v karte Formulas (Vzorce) tlačidlo Trace Precedens 

(Predchodcovia) (aby sme zistili, ktoré bunky vo vzorci používame, tzv. predchodcov) alebo kde sa 

bude náš výsledok ďalej používať (Trace Dependents (Následovníci), tzv. následovníci) v skupine 

Formula Auditing (Kontrola vzorca). 

 

V nasledovnom obrázku vidíme ukážku sledovania predchodcov (Trace Precedens - Predchodcovia). 

V našom príklade sme chceli vedieť ako sa počíta Spolu s DPH (bunka G2). Vidíme, že pre svoj 

výpočet„využíva” bunku F2.  
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V bunke F6 vidíme vo výpočte„zahrnutie” buniek B6 až E6. Vzorec v bunka C9 počíta so všetkými 

bunkami F2 až F6 (Excel oblasť označil modrou čiarou).  

 

Špeciálny prípad je bunka C10, ktorá obsahuje odkaz na hodnotu iného hárka (alebo zošita). Nad 

bunkou sa zobrazuje prerušovaná čiara s ikonkou tabuľky. Po dvojkliknutí na čiaru sa zobrazí okno s 

odkazom na hárok alebo zošit.  

 

Poznámka: Šípky odstránime kliknutím na Remove Arrows (Odstrániť šípky) v karte Formulas 

(Vzorce) v skupine Formula Auditing (Kontrola vzorca). 

Kontrola chýb 

Karta Formulas -> Error checking (Vzorce > Kontrola chýb) 

V prípade ak dostaneme v bunke chybný výsledok, Excel nám dokáže „poradiť” v čom nastal problém. 

 

 
 

Označíme bunku, v ktorej sa vyskytla chyba a prejdeme do karty Formulas (Vzorce) a Error checking 

(Kontrola chýb). 
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Máme možnosti: 

Help on this error (Pomocník k tejto chybe) – táto možnosť zobrazí pomocníka s popisom chyby 

 

Show Calculation Steps (Zobraziť kroky výpočtu) – pre odhalenie chyby smerodajný krok. Excel nám 

pomôže odhaliť chybu tým, že vyhodnotí výpočet a to s aktuálnym zobrazením hodnoty výpočtu. 

Výpočet robíme krok za krokom cez tlačidlo Evaluate (Vyhodnotiť). 

 

 
 

Ignore Error (Ignorovať chybu) – chybu jednoducho ignorujeme 

 

Edit in formular bar (Upraviť vo vzorcovom paneli) – Excel nás požiada, aby sme vzorec vo 

vzorcovom paneli upravili do správneho tvaru 

Podmienené formátovanie 

Karta Home -> Conditional Formatting (Domov > Podmienené formátovanie) 

Podmienené formátovanie použijeme v prípade, ak potrebujeme vizuálne (napr. farebne) odlíšiť  

údaje v tabuľke (aj kontingenčnej) a to podľa nami zadaného kritéria. Napr. chceme v tabuľke kníh 

farebne (červenou) označiť všetky knihy, ktoré majú viac ako 300 strán. 

Tabuľka vyzerá nasledovne: 
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V prvom kroku musíme označiť bunky. V druhom kroku prejdeme do ponuky Conditional formatting 

(Podmienené formátovanie) a zvolíme možnosť Highlight Cells Rules (Pravidlá zvýrazňovania 

buniek) a potom Greater Than ... (Väčšie ako ...) 

 

kde zadáme 300 a vpravo farbu textu, výplne, orámovanie alebo aj typ hodnoty bunky. 

 

Tieto pravidlá môžeme kedykoľvek upravovať/kumulovať/odstrániť a nájdeme ich v 

ponuke Conditional Formatting  a Manage Rules... (Podmienené formátovanie > Spravovanie 

pravidiel) 
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Ďalšími zaujímavými možnosťami v ponuke Conditional Formatting (Podmienené formátovanie) je 

použitie napr.  Data bars (Údajové pruhy), Color scales (Farebné škály) alebo Icon sets (Množiny 

ikon), pri ktorých sú údaje vizuálne odlíšené veľkosťou pruhu (podobne ako pri grafe) = Data bars 

(Údajové pruhy), resp. farebne napr. od studených (najnižšie hodnoty) až po teplé farby (najvyššie 

hodnoty) = Color scales (Farebné škály), resp. ikonkami charakterizujúce pokles, nárast alebo útlm = 

Icon sets (Množiny ikon). 

 

Nevýhodou takéhoto podmieneného formátovania je to, že farebne sú odlíšené len označené bunky. 

V prípade ak chceme farebne odlíšiť celé riadky je potrebné použiť v pravidle použitie vzorca. 

Vysvetlíme si ako na to. V prvom kroku označíme tabuľku údajov okrem prvého riadka (ak je prvý 

riadok hlavička tabuľky). 
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Potom prejdeme do ponuky Conditional formatting (Podmienené formátovanie) a zvolíme 

možnosť New rule... (Nové pravidlo). Ďalej označíme možnosť Use formula to determine which cells 

to format (Použiť vzorec na určenie buniek, ktoré sa majú formátovať), ktoré sa majú formátovať a 

nižšie zadáme vzorec. Napr. ak máme v stĺpci F čísla strán kníh a chceme farebne vymedziť knihy nad 

300 strán, tak zadáme vzorec =$F2>300 a nezabudneme na zvolenie vhodného formátu 

(tlačidlo Format... pod vzorcom). Použitím značky $ (fixovanie) sme zabezpečili, že Excel bude hodnotiť 

iba stĺpec F a to všetky riadky (1-tka nie je fixovaná, lebo je to hlavička tabuľky), tak ako ukazuje 

nasledovná tabuľka: 

 

Kontingenčná tabuľka 

V prvom rade si povieme definíciu kontingenčnej tabuľky. Podľa slovenskej wikipédii je nasledovná: 

Kontingenčná tabuľka je tabuľka, ktorá sa používa na prehľadnú vizualizáciu vzájomného vzťahu dvoch 

štatistických znakov. 

Moja vlastná definícia: 
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Kontingenčná tabuľka slúži na rýchle sumarizovanie, analýzu a filtrovanie údajov. 

Aby sme si povedali v praxi, ako sa to myslí si môžeme prečítať ďalej. 

Máme napr. tabuľku realizovaných zákaziek, ktoré si rozdelíme podľa ich rozsahu (napr. na veľké, 

stredné a malé). Každej zákazke sme pridelili náklady v €. Zákazky boli realizované v rokov 2003, 2004 

a 2005.  

Aby ste si vedeli predstaviť, ako taká tabuľka so vstupnými údajmi vyzerá, pozrite si ju nižšie.  

  

 
A teraz si predstavme, že potrebujeme zistiť Celkové doterajšie náklady podľa Rozsahu Zákazky a 

Dátumu zahájenia v konkrétnych rokoch spolu. 

Takýto sumár by sme nedokázali spraviť cez filter, preto použijeme Kontingenčnú tabuľku. 

Kontingenčnú tabuľku vkladáme prostredníctvom karty Insert a PivotTable 

  

 
V prvom kroku po vložení kontingenčnej tabuľky je potrebné označiť oblasť buniek (Select a table or 

range), ktoré budeme brať do úvahy. Môžeme sa rozhodnúť, či chceme kontingenčnú tabuľku vložiť 

do nového pracovného hárka alebo existujúceho. Zvoľme nový pracovný hárok – New Worksheet. 
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Ak súhlasíme s oblasťou údajov, ktoré vám Excel automaticky označil, potvrdíme jednoducho OK.  

  

Výsledkom je novovytvorený hárok, ktorý obsahuje akúsi prázdnu tabuľku vľavo a napravo stĺpec 

(tablu) so všetkými názvami stĺpcov, ktoré sme vytvorili v zdrojovej tabuľke. 

  

Takže vráťme sa k nášmu zadaniu. Chceme zistiť celkové náklady v € za celé obdobie (roky 2003 až 

2005) podľa rozsahu zákazky (tie sme rozdelili na malé, stredné a veľké). A teraz príde tá jednoduchosť 

kontingenčných tabuliek. Napravo len začiarkneme možnosť Rozsah_Zákazky, Dátum 

zahájenia a Doterajšie náklady. A je to! Ako ste si už všimli, tabuľka naľavo si už doplnila nami 

požadované údaje a to aj vo forme sumárov. 

 

 
  

Teraz by sme však potrebovali nejakým spôsobom zoskupiť dátumy tak, aby sa zobrazili ako roky a nie 

jednotlivé dátumy a zároveň nás zaujímajú konkrétne náklady. 

Klikneme pravým tlačidlom, kdekoľvek do dátumu, napr. 6.11.2003 (v stĺpci Row Labels pod 

slovíčkom malá) a zvolíme možnosť Group ... ako je to na tomto obrázku: 
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kde sa nám otvorí nasledovné okno: 

  

 
 

Označme len roky (Years) (alebo podľa potreby, napr. štvrťroky, mesiace, atď) a potvrdíme OK. 

Dostaneme sumarizáciu nákladov podľa rokov, tak ako sme to chceli od začiatku ako to ukazuje tento 

obrázok: 
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Chceli by ste však vidieť roky a tie podelené podľa rozsahu zákazky? Jednoduché! Stačí prehodiť 

napravo v časti Row Labels poradie stĺpcov  Rozsah_Zákazky a Dátum_zahájenia a je to. 
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Zmena funkcie v kontingenčnej tabuľke – súčet na priemer, počet, maximum, 

minimum a ďalšie 

V bežnej praxi v kontingenčnej tabuľke okrem súčtu môžeme využiť aj ďalšie funkcie. Tie, ktoré nám 

Excel ponúka sú: Priemer (AVERAGE), počet (COUNT), maximum (MAX), minimum (MIN), súčin 

(PRODUCT), spočítať čísla (COUNT NUMBERS), odhad smerodajnej odchýlky (STDEVP), smerodajná 

odchýlka (STDEV), odhad rozptylu (VARP) a rozptyl (VAR). 

Zmenu funkcie môžeme spraviť priamo v kontingenčnej tabuľke a to cez pravé tlačidlo v oblasti, kde 

máme číselné hodnoty (oblasť s názvom VALUES). Vyberieme ponuku Value Field Settings ... 

 
Rovnakú ponuku nájdeme aj po kliknutí na oblasť VALUES – tá sa nachádza vpravo dole. 

 
V ponuke, ktorá sa nám zobrazí, zvolíme príslušnú funkciu a potvrdíme OK. 
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Pomocník 

Činnosť Vysvetlenie 

Čo je pomocník Miesto, na ktoré sa môžete rýchlo dostať pomocou 
klávesovej skratky F1, príp. sa tam nachádza 

možnosť Zadajte otázku , ktoré je 
umiestnené v pravom hornom rohu okna programu 
na paneli s ponukami. Do tohto poľa napíšte svoju 
otázku. Po zadaní otázky potvrďte ENTER. Výsledkom 
je zoznam tém, na ktoré môžete kliknúť (podobne 
ako na internete) a prečítať si radu krok za krokom, 
tak akoby ste čítali príručku. 

 


